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Where to find more information

Online Help Use online Help for in-depth information beyond what is shown
in this Quick Start Guide. Display online Help in any of the following ways:

¢ (Click the Help button in the toolbar.
¢ Select Help Topics from the Help menu.
¢ C(Click the Help button on most dialog boxes to show task-specific help.
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User Guides Besides this Quick Start Guide, the following guides are
available from the Resource App after installation.

* Agilent ChemStation Edition Familiarization Guide

o Agilent InfinityLab LC/MSD Series and 6100 Series LG/MS Concepts Guide

o Agilent InfinityLab LG/MSD Series System Installation Guide

o Agilent InfinityLab LG/MSD Series and 6100 Series LG/MS Maintenance Guide
After installation, open the LC-MSD Resource app to access MSD-specific
user guides and training material. Click App Start > All Programs > Agilent

Technologies > OpenLAB CDS Documentation to access other user guides
for your system.

Getting Started Self-paced training modules to learn about the mass selective
detector and ChemStation Edition software are available from the Resource

App.

What's new in C.01.08

¢ ChemStation Edition program now started from Control Panel.

¢ Agilent I/0 Libraries Suite no longer supported. I/O Libraries Suite must be
obtained from Keysight Technologies.

¢ Support for InfinityLab LC/MSD Series instruments.
* Improved user interface.

¢ Improved Intelligent Reporting support for LC/MSD data.
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To start the ChemStation Edition program

Lo

2 Click Launch.

Control Panel

1 Click the Control Panel icon the Desktop to open the Control Panel.
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Configuration Diagrams

Configuration Diagrams

InfinityLab LC/MSD Series with 1100/1200/1260/1290 Series LC

Solvent bottles
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MSD
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ChemStation Edition Views

ChemStation Edition Views

The ChemStation Edition software consists of several views. Click one of the
view buttons in the lower left corner of the screen, or from the View menu, to
change to a different view.

Hﬂ Method and Run Control

By ] Data Analysis
ﬁ Report Layout

% Verification (0Q/PV)

@ Diagnosis

Cﬁ' M5D Tune

Method and Run Control View Allows you to set up methods and adjust
instrument parameters to inject samples and acquire data one sample at a
time or in automated sequences. See the next page for more information.

Data Analysis View Allows you to perform various data evaluation tasks on
chromatograms and spectra, such as integration, quantitation, checking peak
purity, deconvolution, and report generation. See page 9 for more information.

Report Layout View Allows you to design custom report templates to use with
the data generated by your ChemStation. See page 12 for more information.

Verification (0Q/PV) View For use by Agilent service engineers to determine
if your system is operating in a predictable manner. This view is useful to
show Good Laboratory Practice (GLP) compliance, which some government
agencies can require. See page 13 for more information.

Diagnosis View Allows you to run tests to diagnose instrument problems and
access information on how to resolve these problems. The early maintenance
feedback (EMF) feature can notify you when it is time to perform system
maintenance before a problem occurs. See page 15 for more information.

MSD Tune View In this view, you can calibrate your MSD automatically. You

can also set MS parameters manually for specific types of molecules. See
page 16 for more information.
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ChemStation Edition Views

Method and Run Control View
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The user interface for Method and Run Control can be configured in two ways during
installation. See Agilent InfinityLab LC/MSD Series System Installation Guide for
information on installation and configuration.

If your instrument is configured with the Classic user interface, then see ChemStation
online Help and these manuals on the Resource App:

e Quick Start Guide
e Familiarization Guide
e Concepts Guide
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ChemStation Edition Views

Status and Bun  Right-click the Method icon to see the following commands:
Bars: Instrument Run Time Checklist, Method Information, Edit Entire Method, Method Audit

Control Tab  Trail, Print Method, and Help.
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Each icon of the system diagram represents one component or module of your
system. Click on an icon if you want to edit the method parameters or go to the

online Help for that particular component.
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ChemStation Edition Views

Single Sample
Tool Set

Sequence
Tool Set

Flow Injection
Analysis (FIA)

This toolset allows you to work on methods and run an analysis for a single
sample. Move the cursor over a button to view a description of it.

- Click the Single Sample icon to display this toolset.

This toolset allows you to work on sequences and run automated analyses of
multiple samples. Move the cursor over a button to view a description of it.

Click the Sequence icon to display this toolset.

i
L—Mﬂggm@c

This toolset allows you to inject multiple samples directly into the detector,
which lets you bypass the chromatographic column. The results are sent to a
single data file. FIA can be used for method development or for applications
that do not require chromatography.

T T 3 To enable FIA from the system diagram:
il + Click the FIA icon.
+ Select Edit FIA Series.
» Mark the Enable FIA Series in Method option and edit the
FIA Table.

B ”|- Edit FIA Series

Method

Edit FIA Series.., I
il Help [ Enable FIA Series in Method

|—EIA Table
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ChemStation Edition Views
Data Analysis View

Data Analysis View

Navigation Tools Cursor Tools
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Message Line

The various tool sets available in Data Analysis View are shown on the

following pages. You can view a description of a button by moving the cursor
over it.
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ChemStation Edition Views

Common Tool Set This toolset is always present in Data Analysis view.
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Graphics Tool Set Allows you to manipulate the graphic display.
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Integration Tool Set Allows you to perform integration and reporting tasks on
a chromatogram.
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ChemStation Edition Views

Calibration Tool Set Allows you to perform calibration tasks for quantitation.

' ﬁi} @a} @ ﬂl M | Report:  Shart -—E _l ﬂ .
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Signal Tool Set Allows you to work graphically with the UV or MS signal.
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Purify Tool Set Allows you to work graphically with your purification data.
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Spectral Tool Set Allows you to perform spectral evaluation tasks.
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Deconvolution Tool Set Allows you to transforms mass spectra from
multiply-charged ions into a calculated molecular weight.
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ChemStation Edition Views
Report Layout View

Report Layout View

Report Template Calculation Technique

File Edit View Abort Help | I

7 [Report

0000 -0-0000 X000 600D

New Section Menu

“:f Agilent Technologies

Report Section

Message Line L

Report Layout

Tool Set This toolset is present in the Report Layout view. Move the cursor
over a button to view a description of it.

0209 -© 0008 x000@eoed

Tips ¢ Edit or create a report layout as described in the online Help.

¢ To test your report layout, select a calculation technique from the
drop-down list box to define how the results are calculated.

¢ Load a data file. The results are loaded into the report template using the
selected calculation.

¢ Select File / Add to Report Styles to add your completed report template
to the list of available report styles. Now you can use your customized
report within a method.
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Verification (0Q/PV) View

Start/Stop Run

ChemStation Edition Views

Verification Toolbar
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The

Verification (OQ/PV) view lets Agilent service engineers test whether your

analytical instruments and the ChemStation software are operating correctly

according to predefined performance criteria.

Operation Qualification (0Q) Operation Qualification is the documented
verification that the equipment-related system or subsystem performs as
intended throughout representative or anticipated operating ranges.
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ChemStation Edition Views

14

Performance Verification (PV) Performance Verification is the documented
verification that the process and or the total process-related system performs
as intended throughout all anticipated operating ranges.

System Diagram Each icon of the system diagram represents one component
or module of your system.

Verification Toolbar The Verification toolbar is displayed when you select
Show Top Toolbar from the View menu. Move the cursor over a button to view
a description of it.

BB e 3 TN S

Available Tests The following verification tests are supplied with your
ChemStation software for use by an Agilent service engineer. Refer to the
online Help for more information on these tests.

¢ VWD Wavelength Accuracy

¢ Intensity

¢ Holmium

e Temperature Accuracy

¢ Noise, Flow, Temperature

¢ DAD Wavelength Accuracy

¢ Injector Precision

¢ Detector Linearity/Carry-over
* Injector Linearity

¢ Gradient Composition
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ChemStation Edition Views

Diagnosis View
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Information Pad
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This view allows you to carry out diagnostic and maintenance activities on
your system.

Diagnosis Toolbar The Diagnosis toolbar is displayed when you select Show
Top Toolbar from the View menu. Move the cursor over button to view a
description of it.
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ChemStation Edition Views

MSD Tune View

Title Bar MSD Tune Toolbar Status Bar
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MSD Tune Toolset

This toolset is present in MSD Tune view.

Load an MSD tune file. Calibrate the mass axis.
= L
o o
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1 Wca
By o parameters.
Generate a profile and scan o Edit MSD parameters for manual
report. = tuning.
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i tune report. LJm_l results to data file.
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Basic Operation

Start up and shut down the system

Basic Operation

Task

Instruction

Comment

To start up the system

To put the system in Standby Mode

1 From the Method and Run Control
view, click the () button on the
system status bar. When you move
mouse over the button, if system is
currently idle, it turns green.

2 Set up the LC conditions (pump,
column heater, and detector).

3 Set up the MSD spray chamber
conditions as described in the MSD
Spray Chamber dialog box topic in
the online Help.

Allow 15 minutes for the system to warm

up.

1 Flush the system with pure mobile
phase to ensure that the flow path is
clear of buffers. This prevents the
nebulizer from plugging. A plugged
nebulizer can cause a high back
pressure, which can damage the LC
flow cell.

It is good practice to flush the flow
path (including the column) for 5 to 10
minutes with a mobile phase without
buffers such as 50:50
water/acetonitrile.

2 Click the () button on the system
status bar. All modules are set to
standby mode (indicated by the gray
color in the system diagram).

This procedure assumes that the
system is under vacuum and the LC
and MSD are properly connected. It
also assumes that the liquid flow path
is properly set up.

Put the system in standby mode
overnight or whenever you are not
analyzing samples for an extended
time. The standby state for the MSD
leaves the nebulizer and drying gas on
at low flow.

Standby for the MSD is:

+ 20 psi for the nebulizer,

* 3 L/min for drying gas,

+ 300 °C for drying gas temperature,

+ 325 °C for the APCI vaporizer, if
present

+ the MS stream selection valve is
set LC to Waste.

For Agilent Jet Stream source:

+ Sheath temp 100°C
+ Sheath gas flow 2.2 L/minute

Agilent InfinityLab LC/MSD and 6100 Series LC/MS Systems Quick Start Guide 17



Basic Operation

Tune the MSD

When the MSD is used as a detector for the LC, a mass spectrum is associated
with each data point in the LC chromatogram. To obtain high quality, accurate
mass spectra, optimize the MSD to:

* Maximize sensitivity
¢ Maintain acceptable resolution

¢ Ensure accurate mass assignment

Tuning is the process of adjusting MSD parameters to achieve these goals.
After the MSD parameters have been optimized, they must be saved in a tune
file (.tun). This tune file is then specified in the method that is used to acquire
data for your samples.

Frequent tuning, whether automated or manual, is not required. Once tuned,
the MSD is stable. Tuning is needed no more often than monthly, weekly at
most.

Wait 4 hours after pumpdown before tuning or operating your MSD. The
analyzer takes about 11 hours to reach thermal equilibrium. Tune files that
are created or data that is acquired before the MSD is at thermal equilibrium
can have incorrect mass assignments and other inaccuracies.

Task

Instructions Comments

To use Autotune

1 From the MSD Tune view, select Use autotune for automated
Autotune from the Tune menu or click adjustment of the MSD performance.
the Autotune toolbar button.

2 Review the tune report that is printed
automatically when tuning is
completed.

18
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Basic Operation

Task

Instructions

Comments

To use Check Tune

To use Manual Tune

1

Select Check Tune from the Tune
menu.

Review the Check Tune report.
Adjustments are suggested for values
that are outside of acceptable ranges.

Select Manual Tune from the Tune
menu.

Set the desired mass resolution
(adjusting width gain and width
offset).

Calibrate the mass axis (adjusting
mass gain and mass offset).

Optimize the ion transmission through
the source ion optics (fragmentor,
skimmer(s), lens 1, lens 2, and
octopole peak).

Adjust the signal strength (setting iris
and adjusting the multiplier gain).

Fragmentor and gain are method
parameters. The fragmentor affects ion
transmission and fragmentation. For
more information, see the online Help.

Use Check Tune to determine quickly
whether the MSD is correctly tuned. It
performs a single profile scan of the
tune masses and compares the peak
widths and mass axes with target
values.

Use Manual Tune when you want to:

+ Achieve maximum sensitivity by
sacrificing some resolution

« Tune specifically for the very low
end (<150 amu) of the mass range

+ Tune with a compound other than
the standard calibrants

Agilent InfinityLab LC/MSD and 6100 Series LC/MS Systems Quick Start Guide
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Basic Operation

20

Acquire MISD Data

Modes of Acquisition

There are three modes of acquiring data:

* Running a method for a single sample

¢ Running a sequence for multiple samples

Running an FIA series

Note the following about acquiring data:

All three acquisition modes require an appropriate method.
Samples can be injected either manually or with an ALS.
Always start a run from the software.

An FIA method cannot be used in a sequence but multiple FIA methods can
be run sequentially.
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To edit a method and start a run

Basic Operation

Once you know the acquisition mode that you want to use, you must set up an
appropriate method. Methods are set up in the Method and Run Control view.

Instructions

Comments

1

Activate the single sample toolset by clicking the
@ button on the toolbar.

Load a method by selecting Method / Load Method
or by clicking the [z button on the toolbar and
selecting a method from the list.

Clickthe g button to begin editing the method. You
can also begin by selecting Edit Entire Method from
the Method menu or by right-clicking the m icon
on the Run Control Bar.

Select the method sections you want to edit (select all
sections to become familiar with the method
parameters that are available) and click OK.

Add any method comments you want to appear on
your reports.

Set up the instrument parameters, such as pump,
injector, DAD or VWD, column thermostat, MS
signals, and MS spray chamber.

Set up the Data Analysis parameters, such as signal
details, integration events, report parameters,
instrument curves, calibration curves, calibration
table, and ion parameters.

Complete the Run Time Checklist.

Save the method using a different name. Select
Method / Save Method As or click the [, button on
the toolbar.

10 When you are ready to begin a run, click the Start

button.

A series of dialog boxes is displayed,
which allows you to set up your
method and instrument parameters.

Click the Help button on any of the
method dialog boxes for descriptive
information on the items available in
each.

Once you are familiar with the options
that are available, use the system
diagram menus for quick access to
particular method parameters.

Agilent InfinityLab LC/MSD and 6100 Series LC/MS Systems Quick Start Guide
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Deconvolution

Deconvolution

Deconvolution is an optional process (additional license required) that
transforms mass spectra from multiply-charged ions into a calculated
molecular weight.

To deconvolute a mass spectrum

Instructions

Comments

1

In the Data Analysis view, load an electrospray MS
data file. The TIC is displayed.

Generate the MS spectrum that you want to
deconvolute. (Select the Spectral task tool set and use
the spectrum selection tools to pick the spectrum of

interest).
Click the Enter Deconvolution Tool buttonto
set up the deconvolution display area. LLLLI

When the spectrum is displayed, click the
Label lons button to locate masses to be ITJJ_l
used in deconvolution.

Examine the ions that were found. Very noisy data or
data with unresolved regions often need special
settings to find ions.

Click the Edit Deconvolution Parameters
button to change any of the parameters.
YA m
Click the Run Deconvelution button to begin
the deconvolution process. l“‘}_ﬁ_

These operations are performed on
data acquired in full scan mode.

You can use the lon Label
Options button to optimize ﬂfﬂ
the set of ions found.

Once the deconvolution is done, the
components are displayed in the
upper right window. The charge states
are displayed in the lower right
window.

22
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Deconvolution

Instructions Comments
8 Select specific components from the Component list ~ Optionally, click the Preview 3
to look at individual components or groups of Deconvolution Report
components. button
or click the Print Report
button. @

9 Optionally, select components from the This action removes the peaks for the
Component List box and then click the lﬁl selected components from the original
Delete Components button. spectrum. You can then continue with

10 Repeat the process. step 4 (previous), using this new
spectrum.

Deconvolution Report

The Deconvolution report contains summary information about each
component selected, along with detailed information on how each peak in a
component contributes to the molecular weight of the component. In the first
part of the report, the components are ranked by percent relative abundance,
which is useful for estimating the percent of impurities.

The actual molecular weight can differ from the computed molecular weight
even if the data fit a Gaussian curve perfectly, due to other errors such as
errors in mass axis assignment or unresolved chemical impurities.

The Deconvolution software is optional and is part of the ChemStation Edition
C.01.xx or M8363AA (ChemStation C.0x) Bioanalysis Software package.

Agilent InfinityLab LC/MSD and 6100 Series LC/MS Systems Quick Start Guide 23



Operating Tips

Operating Tips

24

Back up your data and methods regularly to avoid loss of data in case the
files are accidentally overwritten, deleted, or if a hardware problem
develops with your disk drive.

Put the system in standby mode overnight or whenever you are analyzing
samples for an extended time.

Verify that the tune file you are using is appropriate for your samples.

Save the Tune reports as a PDF file or print the report, as part of your
maintenance log.

Regular system maintenance can reduce problems. Keep a maintenance
record.

Use the Maintenance Logbook and EMF features in Diagnosis view to help
you track when maintenance is needed and to keep an online maintenance
record.

Flush the sample path and clean the spray chamber, capillary tip, and spray
shield daily or at the end of each shift. Check the foreline pump fluid level
every week.

The spray chamber vent hose must be connected to a lab vent that is used
only for the source. The vent hose must be separate from the vent hose for
the foreline pump. Otherwise, pump exhaust can migrate into the spray
chamber vent producing chemical noise.

Samples must be filtered. If no chromatography is used, they must be salt
and detergent-free.

If a UV detector is available, use it in series with the MSD. Try to minimize
chromatographic peak broadening by using low dispersion tubing.
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Operating Tips

* To minimize chromatographic band broadening, be sure that all tubing
connections are free of dead volume. Use zero dead-volume (ZDV) fittings

when possible.

¢ Use the following table as a guide to using SIM, condensed scan, and full

scan acquisition modes.

Task Mode
Acquire electrospray data for samples containing large, Full Scan
multiply-charged analytes.

Analyze a mixture with unknown components (small molecules). Scan
Analyze a mixture with known components in unknown amounts Scan or SIM
(quantitate).

Identify the presence of a few known compounds at low levels SIM

within a mixture.

Use fast chromatography on 1.0-MHz MSD systems (LC/MSD and Fast Scan

LC/MSD XT) without missing peaks.

Agilent InfinityLab LC/MSD and 6100 Series LC/MS Systems Quick Start Guide
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Troubleshooting Tips

Troubleshooting Tips

No peaks
v/ Verify that there is spray from the nebulizer.
v/ Verify that the capillary voltage is set correctly.

¢’ In APCI mode, verify that the corona needle is installed.

In APCI mode, verify that the Corona Current setting is 2 uA or higher, and
that the Corona Voltage is between 1500 and 5000 V.

v’ Verify that the MS system is tuned correctly.

v/ Verify that MS vacuum pressures are within normal ranges.

¢/ Check the drying gas flow and temperature.

v/ Verify that the fragmentor is set correctly.

v/ Check if any error message indicates a problem with electronics.

v/ Verify that sufficient sample is present in vial.

Poor mass accuracy

v/ Recalibrate the mass axis.

v/ Verify that the ions used for tuning span the mass range of the sample ions
and that they show strong, stable signals.

Low signal

¢’ Check the solution chemistry. Verify that the solvent you are using is
appropriate for your sample. Mixed samples can exhibit signal suppression
of one or more components.

v’ Verify that the sample is fresh and has been stored correctly.
v/ Verify that the MS system is tuned correctly.

¢/ Check the nebulizer condition.

v/ Clean the capillary entrance.

v/ Check the capillary for damage and contamination.
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v’ Verify that the spray chamber parameters are set correctly, such as drying
gas heater and nebulizer pressure.
Unstable signal

v/ Verify that the drying gas flow and temperature are correct for the solvent
flow you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v/ Verify that the LC backpressure is steady; steady backpressure indicates a
steady solvent flow.

High spectral noise

v/ Use appropriate mass filter values.

v/ Check the spray shape. Nebulizer can be damaged or incorrectly set.

v/ Verify that drying gas flow and temperature are correct for the solvent flow
you are using.

v/ Verify that the solvent is thoroughly degassed. Do not use ultrasonic
degassing with protein samples.

v/ Verify that the LC backpressure is steady; steady backpressure indicates a
steady solvent flow.

v/ If you are using water as part of the mobile phase, verify that it is deionized
(>18MQ).
Droplets, not spray, exiting the nebulizer

v/ Verify that the nebulizing gas pressure is set high enough for the LC flow
being used.

v/ Check the position of the needle in the nebulizer.

v/ Stop the solvent flow and remove the nebulizer assembly. Use a magnifying
glass to examine the end of the nebulizer for damage.
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No flow

v/ Verify that the LC pump is on and there is sufficient solvent in the correct
bottle.

v/ Verify that the solvent supply lines are free of air bubbles. Purge the
appropriate pump channels, if needed.

v/ Check for LC error messages.

v/ Check for blockages. Repair or replace any blocked components.
v/ Check for leaks.

v’ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation
v Fragmentor is set too high.
v/ Ionization is causing fragmentation (APCI vs. Electrospray).

v/ APCI temperature is too high.
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